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Inquiry

For anyone with little to no video editing experience, editing videos takes time, a lot of

time. Having little to no experience in editing videos seems like a daunting task but once learned

is quite simple. Also having to use software programs such as Premiere Pro can be intimidating

for first-time users that plan to use it for social media. Taking time out of a busy schedule to

learn how to do video editing can be one of the hardest choices a person can make, which is why

we aim to create a video between 5 to 10 minutes.

Training Goals & Objectives

The primary purpose of the training is to have the learner be able to edit a video from start to

finish and then be able to have a finished video to post on social media platforms such as Tiktok

and Instagram. The organizational problems we are trying to solve are customer satisfaction and

relationships, and innovation. To address customer satisfaction and relationships is to show that

video helps to engage with their customers through social media, giving their customers

interactions constantly through their videos via social media. For innovation, it is what

companies and small businesses do to develop new ideas and expand their products and services;

which is where video editing comes in. Video editing can easily be made to the company’s

standards or branding and others in the small business can contribute ideas as well, some ideas

could be following trends on Tiktok or Instagram such as the ghost photoshoot trend and use that

to show off products or the business’ location or new and exclusive products for the holiday

months.
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The Constraints

Some of the constraints that will be present involve the plethora of information available

on Youtube. The,re are hundreds of videos that present information on the topic of editing, but all

of them are close to or over a year old. This presents an issue due to the frequency of software

updates that can create meaningful changes in a user’s experience. Additionally, an issue will be

having to make sure the tutorial is less than 10 minutes because our audience does not have a ton

of time or attention to spend on a tutorial that will only teach them the basics. We will also need

to be sure it is easy to follow and relevant to the current editing style standard as well as follow

the social media trends that are current. Another constraint is that the software that will be

covered for the learner is paid software, which will require them to purchase it before they can

utilize the features within it. Also, another constraint present is that the software will only run on

computers and tablets, and cannot be utilized on smartphones. A final constraint present is access

to a stable internet connection, which is essential for importing media, exporting media to social

media platforms, as well as performing updates on the software to ensure smooth operation.

Task Analysis

Learning Objectives & Outline

What are the learning objectives?

LESSON
# LESSON TITLE LEARNING OBJECTIVES
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#1 Video Tutorial Watch the Video Tutorial or follow along with the
video

#2 Starting to Edit Proceed into Premiere Pro

#3 Import Videos and Audio Be able to Import Videos and Audio into the Project
Window

#4 Change Frame Size Change the Frame Size to 1080 x 1920

#5 Unlink Videos from Audio Be able to Unlink Videos from their Audio

#6 Cut Videos Be able to Cut Videos using the Razor Tool and lining
up the videos to the audio

#7
Add Video Effects and
Transitions Be able to find and add Video Effects and Transitions

#8 Sequencing Effects and
Transitions

Be able to Render Effects In to Out to address the red
line

#9 Exporting Be able to Export following all Export Settings

#10 Be able to find where the saved
video is

Making sure to save the video to the correct folder
and being able to find it for posting to social media

#11 Checklist Make sure to fill out the Checklist to see if objectives
were met

#12 Feedback Provide Feedback to improve how this online course
is presented or arranged

The video(s) need to capture people’s attention faster and hold them longer so they are

interested and invested in that business or person that is being shown on their social media. The

video needs to be able to show what the business or person is and that it has an actual person

behind it so that they are able to make a connection to their audience. Video editing is seen as a

difficult task, requiring special skills to know how to edit videos in a way that creates something

that will gain attention and garner interest. There is a constantly increasing need to establish a

presence on social media as platforms are designed to capture the attention of viewers and

maintain that attention (Alter 2017). The competencies being delivered will include video

editing, image editing, and the importance of creating content tailored to popular trends. Keeping
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up with trends will be the only dynamic aspect of the design. It will be important to include

information on trends that are translatable across time for this reason, as the audience the learners

are targeting will be motivated to absorb content that pertains to current trends or “challenges”

(Ahles, Nilsson & Sandstrom, 2020). The importance of this aspect is evidenced by accounts

owned by businesses who participate in social media trends, even when it does not specifically

pertain to their business gaining a lot of traffic and views. This includes accounts such as Scrub

Daddy, a popular brand that makes sponges and runs a TikTok account that uses popular sounds

and trends in nearly every video. The account has 7.3 Million likes as of September 11th, 2021.

It is clear that using certain sounds or creating videos under certain hashtags may not be enough

though as research has emphasized the phenomena of attention and social media in recent years.

This is illustrated simply in the complex ways social media uses our attention, including

competing sources of stimuli, the time capacity of our attention and even our memory (Firth et.

al. 2019). This emphasizes the impact the learner can have if they are able to achieve the

competency of creating a concise, well thought out video showcasing their product or services.

For this reason, the video editing instruction will be the foundation of our design.  The overall

importance of taking advantage of social media and using it correctly could be attributed to the

mere-exposure effect, or the idea that stimuli that have been presented previously will likely be

evaluated more positively than novel stimuli (Inoue & Yagi 2018). Without the knowledge of

how to properly and effectively participate in the world of social media, businesses are likely to

miss out on readily available opportunities to grow their business.

How to edit Videos for TikTok, and Instagram Reels
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Steps on how to edit using Premiere Pro:

1. Open software program Adobe Premiere Pro

2. Select new project or it will already open to a new project window

3. Select the main folder provided to you, named How_to_Edit_Videos that holds video

folders 1-3. The folder you will save your first edited video in is Video_1.

4. Name the video and where to save it then press OK

5. Go to file > import > Select the main folder provided to you, named

How_to_Edit_Videos that holds video folders 1-3

6. Once done importing select on the video(s) just imported and drag them into the timeline

7. To import audio files it is the same as video except that it will be an MP3, MP4, or Wav

are the most universally used. Then select the audio file once it is imported and drag it

into the timeline it will appear under the video(s) depending on how long the audio or

video(s) are. Now your videos and audio should be in the project window

8. Then go to Sequence > select Sequence Settings

9. Then go under the video heading and make sure the Frame size is 1080 horizontal by

1920 vertical (1080 x 1920) or a 9 to 16 ratio (9:16) then press OK.

10. Once video is in the timeline you can start by either leaving alone your audio that you

have in a video or get rid of it.

11. To get rid of it right-click or select the film in the timeline that you want to get rid of the

audio and select on unlink and your video and audio are now separated. You can now

delete your audio and replace it with new audio.

12. We are then going to cut the videos to match up with the audio.
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13. To do this we use the razor tool to cut the videos to match up to the audio, you are

allowed creative liberty to cut the videos as you please or follow along with the video.

Now that the videos match up with the audio it is time to add effects and transitions.

14. To add effects to a video go to your Project window where the double arrows are and

click on the Effects tab > Video Effect > Color Correction > Color Balance then drag it

onto the video clip(s) on the timeline.

15. To add transitions to videos you will need to have either two videos or have cut one

video. Again go to your Project window and click on the Effects tab > Video Effect >

Video Transitions > then select which transition works best or is in trend (currently Film

Dissolve is trending) then drag it between the video clips on the timeline.

16. After cutting, adding effects, and transitions go to Sequence > Render Effects In to Out it

will show up as a box saying that it is rendering the effects and you will see a bar above

your videos going from red to green.

17. Before exporting your video make sure you are clicked on the timeline (it should be

highlighted with a blue box around it).

18. Then go to File > Export > Media

19. The Export Settings box should be popped up and make sure your format is H.264

20. Change the output name to whatever you wish to name it and make sure it is still saving

to the file you want it to.

21. Then make sure it is exporting the video and audio (these will have a box and a

checkmark next to them).

22. Scroll down and make sure your frame rate (usually 24 or 30), field order (progressive)

are correct.
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23. Then select the box saying Render at Maximum Depth.

24. Then you should see 6 boxes unchecked select on the two boxes saying Use Maximum

Render Quality, and Use Previews.

25. Make sure Time Interpolation is selected on Frame Sampling.

26. Then press export and wait for your video to finish exporting.

27. The video will be saved wherever you selected it to be saved into at the beginning.

How we will measure that the learner has accomplished these objectives is if they were

successfully able to import the videos and audio, they were able to edit/cut the video to their

liking, seeing if they added effects and transitions, if they were able to change the frame size -

unless they shot from their own camera/phone they more than likely wouldn’t have had to, if

they were able export the video and know where it is saved on their tablet or computer; we will

know this by them tagging us on social media using the #WorldwideEdits and seeing the videos

they have created from the tutorial video instructions.

Learner Analysis

This project is a comprehensive digital resource for business owners, who are seeking to

improve their presence on social media in order to take advantage of platforms such as TikTok

and Instagram in order to promote their business. In this case the learners would be groups or

individuals who are seeking out a way to use social media to their advantage in promoting their

business, art, ideas, or knowledge but have little to no experience in video editing or have had a

hard time finding success on platforms such as TikTok or Instagram. This can also include
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learners who already have content but need to be able to fit this content into the physical

parameters that social media allows in a more concise, attention-grabbing way. The learners will

be able to meet their social media needs giving them the necessary information such as what

dimensions are needed for TikTok and Instagram Reels (both are 1080 x 1920). We also need to

be able to show cuts, and transitions (i.e. L-cuts, 3D Motion, Dissolve, Immersive Video, Iris,

Page Peel, Slide, Wipe, Zoom transitions, etc) and how they create interest in videos. We also

want to be able to satisfy their “hunger”; whether for gathering more people to a business

location, page, website, or to gather a personal following on social media we will show how to

create a captivating video (Fulgencio 2021). The product and tutorials will be multi-disciplinary

in that groups or individuals from many fields or topics that have an interest in social media

could use the ideas and resources provided. It will be assumed that the learners have some kind

of motivation to learn and absorb the material since they themselves would be pursuing this as a

resource to enhance their knowledge. This would also imply that the materials can be accessed

by learners at a broad range of knowledge and skill levels. This is a model that small or large

businesses should be taking advantage of regardless of the content or products put out by their

business. In this case, we would assume the learner would be motivated to absorb the materials

provided in this resource as business owners would be the ones seeking out a previously

developed product. With that in mind, the tutorials will be applicable in multiple disciplines and

not curated with a specific owner, product, or business in mind. Being that the tutorials will not

be designed for a specific business it will be imperative to include details and concepts that will

be digestible to learners at any level of prior knowledge on the topic of video editing and social

media. Although not guaranteed, it is likely that learners seeking this information will have close
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to no knowledge or a beginner’s level of knowledge on the topic. However, content must be

designed to enhance understanding at any level of knowledge.

Context Analysis

The context in which the program will be delivered is a comprehensive tutorial that can

be accessed digitally and is easy to follow, and you are able to pause the video in case something

is missed. The product will contain elements such as a video example of how to make edits to

videos from start to finish using the Adobe Creative Cloud Suite’s Premiere Pro. This component

will include a video recorded by us that walks through the editing process using various

resources as well as our SME, and how to add the simplest edits such as color corrector,

transitions to liven up the video (will do this in our own video to emphasize the point). The

program will also include resources from other content creators and examples of businesses that

are utilizing the platforms TikTok and Instagram to promote their business and generate traffic.

Since standards and trends change daily in video editing as well as in social media, in order to

keep up to date with such trends make sure the engagement with the audience is at a constant,

meaning that setting up a posting schedule for when videos go out and making sure to stay up to

date with it. The Algorithm in social media takes note of how often the account is active and how

well it is at keeping audience engagement which is why having a set schedule is important, i.e.

Posting Monday, Wednesday, Friday, and Saturday and what times the posts will get the most

attention and viewer interaction (Pelaez 2021). These data analytics add further opportunity for

the users to improve their skill.
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Instructional Design Plan

[Gagné's Nine Elements of Instruction, Learning How to

Edit Videos for TikTok, and Instagram Reels]

The model or theory we based our instruction on is Gagné's Nine Elements of Instruction.

The elements we will incorporate are: Gaining attention - show a video about how it will entice

the audience to be able to gain more followers to business/prospective business. As well as show

audience retention is about how much of each video your viewers watch. It's usually expressed

as a percentage, so if your viewer gets halfway through, they will have a retention of 50 percent

(Bennett 2021). Inform learner of the objectives - how to edit a video from start to finish, how to

use color corrector and transitions to create interest, Stimulating recall of prerequisite learning -

how to shoot a video on phone and how you’re able to keep memories of family, pets, etc,

Presenting stimulus material - have a video with how to edit a video from start to finish,

Providing learning guidance - ability to give learners a video bundle with sample videos to be

able to learn along with video, Eliciting performance - ability to give learners a video bundle

with sample videos to be able to learn along with video, Providing feedback - by accessing this

video learner they will be able to get feedback on the first three videos (i.e. SkillShare), Create a

personal narrative - share our own experiences, they can be a motivating factor for others -- and

help us reflect on our lives and choices, Record interviews (in person or virtually) - The people
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around us and around the world are living history. Their experiences, information, and advice is a

treasure trove waiting to be mined, Make a video tour of a significant location - If students visit a

place -- on a field trip, on vacation or any time -- they can share their learning experience with

others by recording video of it and narrating as they go, Assessing performance - giving

feedback with tips on what the learner accomplished and what they can improve upon, Assessing

retention and transfer - show how powerful video and social media is (Khadjooi et al 2011). The

final product will allow the learner to better understand their target audience, in turn motivating

them to meet the learning objectives.

Existing Content

The content or instructional materials that already exist that we can leverage for our

training is that there are free resources such as freesound.org where you can get sound effects,

music and other sounds for free. These will be useful after the learner has completed the video

tutorials as they will have access to thousands of different sounds that they will be able to use for

future videos. There is also a reading called “In the Blink of an Eye: A Perspective on Film

Editing” by Walter Murch, which is helpful in getting used to some of the terms that are used in

video editing. These are both found in our presentation under Free Resources, these will both

help the learner if they want to use different sound effects or go further into video editing. Adobe

Stock is also a resource that would be useful for finding backgrounds or artwork, however,

Adobe Stock is something you have to have a paid subscription for which the learner will more

than likely have since they will have to purchase Premiere Pro and that should be included. The

leaner can also look at popular social media accounts such as Scrub Daddy, the San Diego Zoo,



EDITING VIDEOS FOR SOCIAL MEDIA 13

and looking up hashtags such as #smallbusiness to get inspiration for videos to shoot and taking

inspiration for editing styles to help improve their focus for the type of image the learner is going

for.

Lesson Number Lesson Title Learning Objective

1 Introduction to Premiere
Pro.

The learner will be able to
use the basics of Premiere
Pro as it pertains to
elements discussed in the
procedural video.

2 Resources for Long Term
Use of InstructionEditing
Procedures

Provides the learner with
tools and resources that
will allow them to use the
content in the document in
the future. The learner will
be able to edit a video.

3 Editing Procedures The learner will become
proficient in editing videos
by using a self-assessment
checklist.
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Design Blueprints
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Design Blueprints infographic

Instructional Implementation Plan

The primary instructional delivery method will be through online learning. The learner

will need a computer or a tablet, Adobe Premiere Pro, Video package from Skillshare, and

optional a mouse for the computer or pen for the tablet.

Communication Plan

Our video tutorial will be online and the learner will be able to purchase it through

Skillshare. The learners will become informed about the instructional program through us

reaching out on social media or from the learner themselves wanting to learn how to edit videos

to be able to make content for social media to promote their business. We will communicate with

the audience about any ongoing basis as it relates to changes, updates, etc through our social

media being Tiktok and Instagram. We will also keep our presentation updated as new trends

come, and update the video by creating a playlist by years to show past trends, and any updates

that occur within Premiere Pro.

Change Management Plan

This training implementation will impact the way people do their work because learning

any new type of process is complex, especially with taking and editing video, it takes time and

videoing for social media is the fun part however editing is where it is time consuming. It can

https://drive.google.com/file/d/1FrGaOeWYtFElCtyxrbl_nZbMZwqDdKDZ/view?usp=sharing
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take anywhere from ten minutes to an hour depending on how long your video is. If the video is

less than a minute or two it should take no longer than ten to twenty minutes, that will only

happen after the learner is able to understand the basics that were taught in the tutorial. We can

help them to adapt to these changes by letting them know that the video is only eight minutes

long, and that they can follow along with the video or use the pictures in the presentation to

follow along. We will also let them know that this is a self taught course so they can learn at their

own time and work at their own pace to complete the video tutorials, we will also provide

feedback for them on their first three videos after they have completed the tutorials.

Training Curriculum and Schedule

For the training to be effective as well as the components of the needs analysis to be met,

the course itself will be easily completed in one session, with the video tutorial only lasting 8:05

minutes. The resources cited above work to show the importance of the length of instruction in

respect to learners’ attention capacities. The total length of the instruction will vary based on the

learner, and how they chose to proceed through the slides. For learners who would prefer to

listen to the instruction, the video is available to be paused and played as projects are created.

For learners who would rather prefer to listen to the instruction, the video is available to be

paused and played as the instruction proceeds. For those who prefer to click through the

procedures in the slides while they edit their own video. For this reason, total time of training

will depend on the learner’s preferences. The table below lists the time need to proceed through

each lesson of the instruction:
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SECTION
#1

Lesson # Lesson Title Audience Time

#1 Watch the Video Tutorial

The learner will either
watch the video and
follow along with the
tutorial or will watch
the video and use the
pictures as their guide
for editing the video(s).

08:06

#2 Take a look at the Free
Resources

The learner will take a
look at the free
resources provided to
them - freesound.org
and “In the Blink of an
Eye: A Perspective on
Film Editing” by Walter
Murch.

05:00

#3 Checklist

The learner will fill out
the checklist to make
sure they are able to
check off almost all of
the boxes.

05:00

#4 Feedback on the Presentation
and Video

The learner will fill out
the feedback to give us
information on anything
that needs fixing for the
first tutorial or if
anything that the learner
would like to see for
future tutorials.

10:00

Training Logistics

This instruction will be made available through the platform Skillshare, which provides

public online classes on a wide assortment of topics for users to explore. In order to participate in

this instruction, the learner will need access to a Skillshare account where they can enroll in the

course. This will assume the learner has available internet and a computer to not only login to
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skillshare and interact with the course, but also to edit their own videos, as well as upload them

to social media after completing the instruction and their own video project is accomplished. To

follow along with the instruction, the learner will also need to have purchased and downloaded

Premiere Pro, which is disclosed to the learner within the course. What the learner does with

their project is up to them, however the instruction will imply that the intent of the finished

content is to be used for social media, meaning the learner will likely also have access to their

own Instagram or Tiktok account.  Finally, the learner will have the course and instruction

available to them to reference at any time after completing the initial training. This will allow

them to follow along with the procedures of how to edit a video however much they need to,

allowing them to be successful in creating video content in the long term.

Practice activities to be used in the instruction, including feedback strategies

The instruction will include resources throughout the written text that will link learners to

resources such as existing internet videos that will illustrate the concepts being covered

throughout the content. Our procedural step by step instruction on editing a video for Tiktok or

Instagram reels will be a screen recorded video. The video will be inserted into the instruction

and intended for use as a side by side comparison to the learner’s own screen so they can follow

along while the instruction is taking place. The entire instructional document will be self paced,

with knowledge checks throughout. These will include short checklists that learners can use to

ensure they have included all elements into their video project. The checklists can be used on

two levels: The first is confirming comprehension for the learner so they know that they are able

to move onto the next sections of instruction. The learners will also be able to use these
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knowledge checks as a tool to reference later, when they are creating additional videos

independently.

Examples and non-examples of the procedure

We would provide the learners with Google Slides that would contain YouTube videos

that change to be up to date with the current trends in video editing as well as for social media to

continually build up skills. For the learner we would also suggest doing some photography work

with their phone or camera since no matter what age anyone can point and shoot a camera and

take a picture with no assistance necessary. Since photography and video are easily accessible,

and in the palm of your hand the use of professional equipment isn’t necessary to create better

content.

Flow

The instruction will be in a linear flow format with the exception of knowledge checks.

The written instruction will be organized in an intentional way. Instruction will begin with

lessons that build a foundation of knowledge for the learner that allows them to comprehend the

importance of the instruction, as well as motivate them to learn. This will be followed by the
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procedural tutorial, which will include the mentioned knowledge checks. Once the learner has

completed the lessons, they will be able to access the material in a non-linear way to confirm the

appropriate application of the material. Finally the concluding lesson will include resources that

can be accessed again later that will allow the learner to maintain an understanding of current

content.

Lesson Number Function Purpose

1) Introduction to
Premiere Pro.

This section will get the
learner’s feet wet into
Premiere Pro, showing
basic functions and
where the locations of
things are. This will
allow for smoother
operation during later
phases of the instruction.

This section will include
resources from subject
matter experts. These
resources will be used to
detail the significance
individual aspects of
video editing have on the
finished product they
will be creating.

2) Resources for Long
Term Use of
InstructionEditing
Procedures

This section will provide
the learner with a step by
step procedure on how to
edit a video. This will
serve to teach the learner

This lesson will have
examples such as Scrub
Daddy from TikTok and
Instagram to show how
to give viewers a
glimpse into what goes
on behind the scenes and
how they should go
about showing the
creation of their products
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how to create their own
content.

as well as customer
interactions and showing
the location of the
business.

3) Editing Procedures

This section will
function as a “send off”
to the learner and will be
used indefinitely as the
learner interacts with
social media. It will
provide them with
sources to keep up with
the constantly changing
aspects of the social
media platforms.

This lesson will have
quick links to
step-by-step procedures
that will allow them to
quickly find instruction
on a specific editing
procedure, style, or
topic. This section will
be accessible to the
learner even after course
completion to allow
them to refresh their
memory and skills
should they need to.

Motivational strategies to be used in instruction

The instruction will discuss two important topics in order to motivate the learner. One

being a full understanding of the learner’s target audience, their motivation, and their interests,

including where these groups are directing their attention on social media. The second

motivational piece of instruction will be resources that demonstrate the impact a well edited
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video can have on its target audience, speaking specifically to the potential the learner has to

create effective content. In one example, Friend illustrates the importance specific edits have on

the story being portrayed in the video, as well as where and why to make these edits (2019).

Basic plans for instructor materials

In the context of our design, learners will be given the instruction in the form of a product

and use the information to absorb and apply information independently. For this reason, tools and

materials will be their own. In order to interact with this procedural learning guide, learners will

need a computer or tablet, a mouse and keyboard, Adobe Suite specifically Premiere Pro. To

complete the step by step process, learners will be using their own content, meaning the learner

will approach the task with an unedited video to use during the instruction.

Testing mechanisms for assessing mastery of objectives

Being that the instruction is self paced, there will be no active instructor direction or

feedback for the learning while interacting with the material. However, the learner will be

provided with a self assessment in the form of a checklist. A study done by Nielsen discussed the

use of self assessment in another learner directed task, writing. The research showed that using

self assessment was an effective way of promoting success of learning during self directed tasks

(Nielsen, 2012). For this reason, the instruction provides the learner with a checklist that will

confirm understanding and allow the learner to feel comfortable moving forward in the lessons.
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Assessment strategies to be used in the instruction

Similar to testing mechanisms, the learner will be assessing their own material. However,

the final lesson in the instruction will specify aspects of the resources provided that demonstrate

the concepts used in the instruction. For example, the learner will be provided with Tiktok and

Instagram accounts that have found success on these platforms promoting their business. The

instructional design will specify aspects of these accounts that the learner can look for to

compare to their own material. An example of criteria the learner could be comparing is whether

their account is actively utilizing trends to create content.

Introductory presentation of instruction

How to Edit using Premiere Pro for Beginners for Tiktok and Instagram Reels - Contains our

Google Slides with video and picture tutorial, access to our Google Drive, checklist, and

feedback.

Checklist - For the learner to be successful they will need to be able to check off almost

everything on the checklist since some learners will want to keep the original audio, or won’t

have to change the frame size since most people will be using their phones to shoot videos.

Formative Evaluation

https://docs.google.com/presentation/d/1g-XTTTA2THCqfYEi8FRQuKi1LhgHd77us5A3_vb6yJI/edit?usp=sharing
https://drive.google.com/file/d/1ytMuVWcTRApH3Ox2ZKQXZ2XB_gKWW9YL/view?usp=sharing
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Feedback - This is the link to the feedback. We will collect responses to make improvements to

the product and keep up to date with the latest in technology and make sure to update the video

whenever there is a major change to Premiere Pro. We will also have a report sharing to show

what findings and trends are needed to improve our product. We will also provide feedback on

up to 3 videos to critique after they have finished the video tutorials; they will be able to do so by

tagging us on social media using the #WorldwideEdits.

Based on the testing that we had, based off of that testing we made revisions to our

presentation by adding additional information such as adding a table of contents for easy access

and locating. We also added to our video downloads slide to let the learner know “If you plan on

working on your project as you go, please have your videos ready before you proceed to the next

slide”. Additionally we added a “Please Note” slide that says “If any issues or errors occur while

using Premiere Pro, or using the videos you can press okay it will not affect your editing or

videos”. As during testing an error occurred for our learner that we had not come across, so we

added this information to let others know that it will be okay if errors occur for them as well. We

were also told by an observer that for computers you can also use the ALT key, and click then

press delete to unlink your videos and audio faster. Which was helpful to be able to add since

hotkeys are used quite frequently to lessen time. In addition we added a note for the learner

telling them that they don’t have to follow the cuts made in the video or in the pictures and that

they can take creative liberty or they can follow the video or pictures as they like. We also added

the reason for using H.264 is because it is the industry standard in the film industry and is widely

used for video formats. Which means that the video will be easily translated to Tiktok and

Instagram. We will implement this video editing tutorial for beginners by selling it on Skillshare,

https://forms.gle/gQjiLzsRCx7W2W8y8
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which is how learners will gain access to the video tutorial in the presentation or on YouTube,

the presentation, checklist, and feedback. Skillshare is an online learning community which we

decided was the best option considering the last year, as well as being able to learn about video

editing at any time and anywhere no matter where the learner is, they will be able to learn at their

own pace and after purchase they will have lifetime access. If the learner forgets something then

they will still be able to go back into the video tutorial, presentation, checklist and feedback.
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